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World Cultures/World History

Grades:  8-10

Multicultural Travel
Exploring World Cultures

Tools

Kit software:  Inspiration;

mPOWER; Talking Walls;

TimeLiner; World Book

Encyclopedia

Other:  Computers; the

Internet; AppleWorks; EdView

Optional:  iMovie; a digital

camcorder; a projection device

Project Duration

Five to seven class sessions over a period of about two weeks

Introduction

Worldwide differences in culture, history, and social organization are among the most fascinating

aspects of the human race. Experiencing these differences first-hand is a primary motivation for

travel to other countries. How can we stimulate students’ interest in other cultures? How do we

encourage them to appreciate the value of learning about another culture in depth?

Project Overview

In this project, students imagine themselves as employees of an adventure travel company that

promises to immerse its customers in the cultures they visit. As trip leaders, students are charged

with the task of preparing background presentations introducing trip participants to the

destinations they will be visiting. These destinations, coincidentally, are the same as those featured

in Talking Walls, and so groups begin their research with this software, and then branch off from

there to gather the information they need to build mPOWER presentations on the historical,

cultural, religious, and social contexts of the sites (and sights) that will be the highlight of each trip.

Phase 1: Taking a virtual tour of the world

Begin with a discussion of travel as a way of learning about other cultures, beginning to appreciate

their histories, and offering unique ways of perceiving the world and living in it.

Ask groups of four to explore Talking Walls, which teaches about the cultures, histories, and ways

of life of people in different parts of the world by focusing on the walls they have built. After

spending some time reading about all of the different walls, each group chooses a place to which it

would like to lead its trip.
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Each group begins its research by exploring the topics related to its chosen location in the “Beyond

the Walls” section of Talking Walls.

Phase 2: Researching the destinations in depth

Each group learns more about its destination by carrying out research using World Book

Encyclopedia, the Internet, ready-made TimeLiner timelines, and library resources. The group

collects information about the trip highlight (the “wall” itself) and the people, country, or culture

associated with it. They search for information, statistics, photographic images, and maps that relate

to the destination’s past and present. Research notes can be recorded in AppleWorks.

Phase 3: Building the pre-trip presentations

Groups organize the information they’ve collected by making concept maps with Inspiration.

These maps can begin by defining the topics to be covered in the presentations; once these topics

are clarified, the maps may evolve into more detailed storyboards for the presentations.

As a way of giving an historical overview of its destination, each group makes a timeline in

TimeLiner that includes important events related to the country, the culture, and the specific site

being visited.

Based on its storyboard concept map, each group builds its presentation in mPOWER by creating

slides containing text, images, maps, charts, the timeline, and other multimedia elements the group

may have collected in its research.

Phase 4: Introducing trip participants to their destinations

With the class as a whole posing as trip participants, each group in turn presents its slideshow

(using a projection device, if possible). One group member can take charge of navigation on the

computer, while others take turns talking through the presentation.

If time allows after the presentations, lead a discussion about the similarities and differences

among the various destinations.

Technical and Facilitation Tips

Facilitation Tips: Phase 1

m The initial discussion can be facilitated with questions such as the following:

m What other countries have you studied in depth?

m What trips, far or near, are most memorable to you? Why?

m What other countries have you or people you know visited? How were the people and their

culture different from what you experience in your own community?

m Why do people want to learn about other cultures? What is the value of doing this?

m In order to put yourself in the shoes of people from a culture different from yours, what do

you need to know about that culture?
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m Some of the “walls” in Talking Walls are not suitable “destinations” for the purposes of this

project. These walls include Lascaux Cave (closed to the public), the Canadian Museum of

Civilization (too general), and the Vietnam Veterans Memorial (for a variety of reasons). You

may want to advise students of the unsuitable walls when they begin their exploration of Talking

Walls so that they can focus their efforts on the other walls.

m If there is dissent in the groups about which destination to choose, help groups reshuffle or

“trade” members so that all (or most) are satisfied. Each group should choose a different

destination.

m This phase will occupy most of a class session.

Tech Tips: Phase 1

m Navigation of Talking Walls is relatively simple; all options are accessed by clicking icons on the

screen. From the main menu, you can access the Talking Walls book, Beyond the Walls

(background information on each wall), or connect to the Internet. At any point in the book,

click “Beyond the Walls” (at the bottom of the screen) for background information specific to

that wall.

m Encourage groups to use the Notes option in Talking Walls to make notes about their walls.

(The Notes icon is in the lower-right corner of the screen.) These notes can be printed and

added to the information collected in Phase 2.

Facilitation Tips: Phase 2

m Ready-made TimeLiner timelines that relate to the destination being researched can give

students an historical orientation, provide the dates of important events, and suggest new paths

for research.

m The “walls” in Talking Walls are varied and will lead students in different directions. A group

leading a tour to see Aborigine art in Australia, for example, will address different issues than a

group visiting the fortress walls in Cuzco, because the art is located in different places in

Australia. Groups should be able to clarify their goals by keeping in mind the “real world” nature

of the project and by considering these questions: What should a visitor to this place know about

its history, cultural significance, and social context? What should the visitor know about the

people and their values, customs, and ways of seeing the world? In general, groups will want to

deal with language, geography, customs, history, religion, and architecture.

m Here are examples of topics groups might want to address in their research:

m Diego Rivera’s murals: Life of Rivera; relationship with Frida Kahlo; Mexican politics during

Rivera’s life; location of Rivera murals in Mexico; location of murals in the U.S.; topics of

murals; Rivera’s paintings; Mexican history in general.

m Taos Pueblo: Origins of the people; existing pueblo ruins and cliff dwellings to the north and

west; contact with Spaniards in the 1600s; religious beliefs and ceremonies; combining of

traditional and Christian beliefs; pottery of the pueblo people; other pueblos in the upper Rio

Grande valley.

m For walls made a long time ago, student research can focus on the time during which the wall

was made as well as the present. For example, a group researching the Great Zimbabwe Wall

could look for information about the ancient Shona people as well as their modern descendants.
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m If groups are unsure of the kinds of information to look for, have them refer back to the

“Beyond the Walls” section of Talking Walls for guidance. In general, groups can pursue any

topic relevant to the wall, the people, or the place that seems important or might be interesting

to trip participants.

m Groups may want to have their members focus on different topics during their research. For

example, in a group that will lead a trip to see the Animal Carvings in India, one person might

want to research the wall itself, while other members research art and food in India, the caste

system, and Indian politics and history.

m Each group should be encouraged to find a map they can use in their presentation that will show

the location of the trip destination. World Book Encyclopedia is an excellent source of such

maps. See the Tech Tips for Phase 2 for information on searching for maps and converting the

images into graphics files.

m Suggest that students collect graphics files from the Internet and World Book Encyclopedia in

a single folder.

m The amount of class time spent on this phase will be determined by how much research groups

can complete outside of class. If all research is done in class, at least two class sessions will be

required.

Tech Tips: Phase 2

m The information students collect during this phase will be used in Phase 3 to make a slideshow

presentation. Have students save the material they find (including articles, images, and any

video or sound clips) in a designated folder, and suggest that they rename the files with easy-to-

recognize names.

m An easy way to search for maps in World Book Encyclopedia is to use the Atlas. Click the Atlas

icon, click the Map Search button, and then type the appropriate place name. Maps are also

attached to relevant articles as media, and can be located by searching for articles (via Topic

search) as well.

m Images in World Book Encyclopedia (including maps) cannot be exported as files. Therefore,

to use these images in the mPOWER presentation constructed in Phase 3, you must use

AppleWorks to turn each copied image into a graphics file.

1 Make sure the image you want to copy is the only thing in the World Book Encyclopedia

window (click images within articles to access the full-size version; close any caption boxes).

2 Choose Copy from the Edit menu.

3 Open a new painting document in AppleWorks. Choose Paste from the Edit menu. Modify

the image if desired using the AppleWorks tools.

4 Choose Save As from the File menu. Specify a type of file (JPEG is recommended), type a

filename (adding the correct extension, such as .jpg), and select a location in which to save

the file. Click Save. The image can now be added to an mPOWER slide.

m In Netscape Navigator, clicking any image on a Web page and holding down the mouse button

causes a menu to be displayed. Choose “Save this image as” and save the file in a folder reserved

for the purpose of collecting images for this project.
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Facilitation Tips: Phase 3

m To help groups focus their efforts, remind them that they are making the presentations for

imagined groups of Western travelers who are curious about their destination cultures, but know

very little about them.

m Groups are free to organize their presentations as they choose, but be sure to encourage

presentations that involve logical progressions of clearly defined topics, rather than strings of

unrelated facts.

m Groups may decide to assign specific roles for the construction of the mPOWER presentation:

m The information designer leads the processes of (1) selecting which information to include,

(2) deciding how to organize it by topic, and (3) determining the overall structure of the

mPOWER presentation, including links from slide to slide.

m The editor coordinates the process of writing text for the slides (which should be shared by

all group members) and then checks the text for spelling and grammar errors.

m The designer is responsible for the overall appearance of the presentation. It is the

designer’s job to select images, choose fonts and background colors, and arrange the text

and pictures once they have been added to each slide.

m The technical director is the group’s mPOWER “expert.” She or he learns the software well

and uses this knowledge to help the group create the presentation.

m Groups may want to include charts created in mPOWER on their slides as ways of presenting

statistical information, such as the percentages of Muslims, Christians, and Jews in the

destination country (see the Tech Tips for Phase 3).

m In Phase 4, each slideshow will be narrated orally by a student (or a series of students taking

turns at this role). The narration can be relatively simple, serving mainly to point out important

pieces of information, smooth the transitions between slides, and make the presentation more

realistic and engaging. Students should be aware of this expectation when they begin to build

their presentations; they may want to write scripts or speaker notes to follow during the

presentations. See the Tech Tips for Phase 3 for information on how to create speaker notes in

mPOWER.

m Even though the presentations in Phase 4 will have oral components, the slideshows should be

designed to stand on their own.

m Groups have two basic choices in designing the structure of their presentations: they can be

linear or branching. The slides of a linear slideshow can be shown in only one order, but the

presentation is simpler to construct because it does not involve hot button links. A branching

presentation may be viewed according to the wishes of the viewer or presenter, but requires the

addition of hot button links. Typically, a branching presentation will have a single slide (a kind of

table of contents) from which a variety of topics can be accessed by clicking an assortment of

hot button links. If a presentation uses a branching structure, it becomes more like Talking

Walls.

m This phase will occupy at least two full class sessions.
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Tech Tips: Phase 3

m To be used on an mPOWER slide, the TimeLiner timeline must be exported as a graphic. To

export a timeline as a graphic image, follow these steps:

1 Choose the view you want to use, making sure the timeline is only one page, contains

appropriate labels, and has a suitable layout. To work best on a slide, it should fill an entire

page. (See the Step-by-Step Card “Modifying the Layout of a Banner Timeline in

TimeLiner.”)

2 With the chosen view showing on the screen, choose “Export ___ View as Graphic” from

the File menu, and then choose “Save as JPEG file” from the submenu.

3 Select a location in which to save the file, give the file an appropriate name, and click Save.

4 Select the desired image quality by moving the slider (the default, Medium, is usually a good

choice) and click OK.

m To make a chart in mPOWER, follow these steps:

1 Choose Charts from the Slide menu.

2 Click Add New Chart, and then Chart Type.

3 Select the type of chart you want and click OK.

4 Enter the data for the chart in the table.

5 Click “Done with Chart” when the chart is complete.

m To link one slide to another in mPOWER, click Hot Buttons in the Slide Menu, then click Add

New Hot Button. Then choose from the menu how you want the slide to be linked. For

example, you can link to the next slide or jump to a completely different slide. You can also use

hot buttons to play audio or video clips or open a Web site.

Note:  Hot button links are not needed if the slideshow is linear, since simply clicking a slide

during the show advances the presentation to the next slide.

m Remind groups using a branching structure for their presentations that the last slide of any

subtopic should include a hot button linking back to the starting point.

m At any time, groups can preview their slideshow by clicking Show Presentation from the

Presentation menu.

m In mPOWER, you can write speaker notes to go with each slide. When these notes are printed,

they include a thumbnail view of the slide, and can therefore serve as a helpful script for

narrating a slideshow. To create speaker notes in mPOWER:

1 Click the Notes button in the second row of buttons below the view window. (In the

Presentation menu, you need to select the slide first.)

2 Type the speaker notes. The limit is 32,000 characters.

3 To print the notes for the current slide, click Print Notes (the notes for a slide cannot be

viewed during a presentation, so printing them is advised).
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Facilitation Tips: Phase 4

m Before giving their presentations, groups should do at least one “trial run” of their slideshows to

make sure all slides are linked correctly and to give speakers a chance to practice their

deliveries.

Outcomes

After completing this project, students will be able to

m identify culturally significant walls and sites around the world

m explain the significance of a site representing one of the major cultures of the world

m relate knowledge of cultures, world history, languages, and religions to specific places and

countries

m create a multimedia slideshow that communicates information to an audience

In addition, students will have

m broadened their understanding of another culture

m practiced their ability to conduct research using various sources

m developed skills in written, oral, and visual communication and the organization of information

m gained confidence and skill in their abilities to work in groups and contribute to a common goal

m learned skills or acquired knowledge relating to each of the state and national standards referred

to in the Project Standards section

Project Standards

From the Secondary Language Arts & Social Studies Web site, you can identify select state

curriculum standards and national educational technology standards that correlate to this student

project. To locate these standards, go to the kit Web site and click the Curriculum button. Locate

and open this student project and click the “Project Standards” button.

Assessment Suggestions

In Phase 4, each group’s slideshow can be assessed as a communication device by means of a

teacher-created rubric. The rubric may be based on such items as the following:

m The presentation functions properly and shows mastery of basic mPOWER techniques.

m The content seems thoroughly researched and accurate.

m The presentation provides information that will help a trip participant get the most out of the

experience of traveling to the trip destination.

m The information is organized sensibly and communicated clearly.

m Design, formatting, and images work together to make the slideshow more attractive and

interesting.
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Alternatively, the slideshows can be evaluated by means of the “Multimedia Project Rubric”

(located on the kit Web site).

In addition, a group’s presentation may be placed in each group member’s electronic portfolio as

an example of his or her work.

Preparation

m Review and print any of the Step-by-Step Cards that students may find helpful during this

project. These include “Making a Presentation With mPOWER,” “Getting Started With

Inspiration,” “Searching World Book Encyclopedia 2001,” and “Searching the Internet With

EdView.”

m You may want to check out some books from the school or local library in advance, to facilitate

groups during the research phase. Having books available in the classroom will save time, which

could be important if your students are new to mPOWER and require more time to create their

slideshows.

m You may want to collect brochures or Web site addresses of adventure travel companies that

specialize in cultural immersion during their trips (see the Resources section) so that you can

show students how their work relates to the real world.

Resources

Internet

Britannica

http://www.Britannica.com

Desktop Movies in Education

http://www.apple.com/education/dv/

Earthwise Journeys

http://www.teleport.com/~earthwyz/culture.htm

EdView

http://edview.apple.com

Extraordinary Places

http://www.eplaces.com/

The History Channel

http://historychannel.com/

The History Net

http://thehistorynet.com/

History of Peru

http://www.emulateme.com/history/peruhist.htm

The Internet History Sourcebooks Project

http://www.fordham.edu/halsall/
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Journeys International

http://www.journeys-intl.com/index.html

Map Machine@National Geographic.com

http://plasma.nationalgeographic.com/mapmachine/facts_fs.html

Mountain Travel • Sobek

http://www.mtsobek.com/

Open Road Tours

http://www.arizonaguide.com/openroadtours/

Rough Guide (cultural info for all countries listed on the site)

http://travel.roughguides.com/

Secrets of the Great Wall

http://www.discovery.com/stories/history/greatwall/greatwall.html

Talking Walls Web Page

http://www.edmark.com/talkingwalls/

The Virtual Diego Rivera Web Museum

http://www.diegorivera.com/index.html

Western Wall Cam

http://www.discovery.com/cams/wall/wall.html

The WWW Virtual Library History Catalog

http://www.ukans.edu/history/VL/

Books

Australian Aborigines by Richard Nile. Raintree, 1993.

Step-by-Step Cards

m Getting Started With Inspiration

m Making a Presentation With mPOWER

m Modifying the Layout of a Banner Timeline in TimeLiner

m Publishing Your Web Pages With iTools

m Searching the Internet With EdView

m Searching World Book Encyclopedia 2001

m Setting Up an iTools Account

m TimeLiner Basics

m Working With TimeLiner Timelines
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Additional Resources

m Multimedia Development Checklist

m Multimedia Presentation Checklist

m Multimedia Project Rubric

m Organizing Information With Inspiration

Prerequisite Skills

To complete this project successfully, students should be able to do the following:

m use a mouse to navigate through a multimedia application by clicking icons and links

m use AppleWorks to create and edit a simple word-processing document

m make a basic concept map using Inspiration (see the Step-by-Step Card “Getting Started With

Inspiration”)

m make a simple timeline using TimeLiner (see the Step-by-Step Card “TimeLiner Basics”)

m use EdView or other search engines to search the Internet for information and multimedia

relating to a particular topic (see the Step-by-Step Card “Searching the Internet With EdView”)

m search for topic-based information in World Book Encyclopedia (see the Step-by-Step Card

“Searching World Book Encyclopedia 2001”)

m make a multimedia slideshow presentation with mPOWER (see the Step-by-Step Card “Making

a Presentation With mPOWER”)

Background Information

Here is some information you may find useful as you plan how to implement this project or

introduce it to your students:

m A variety of companies (see the Resources section) offer tours to places around the world for

people interested in experiencing and learning about other cultures and other countries.

Although most of these companies are commercial in nature, their trips are intended to be

educational.

Options and Extension Activities

Options

m Groups’ presentations can easily be exported as html files and then posted (individually or as a

set) to the Internet. From the Presentation menu in mPOWER, click Output Presentation,

click “Export to HTML,” name the file and choose where to save it, and then click Save. These

files can be published on the Web using an iTools account (see the Step-by-Step Cards “Setting

Up an iTools Account” and “Publishing Your Web Pages With iTools”).

m Copies of the final presentations can be made available to other classes. Alternatively, students

can give their presentations to other classes.
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Extension Activities

m Students can interview other students who are posing as former trip participants and giving

testimonials about their experiences. The interviews can be recorded with a digital camcorder,

edited with iMovie, and then added as desktop movies to the group presentations. For help

using iMovie, visit the “Desktop Movies in Education” Web site.

m Students can use AppleWorks to create illustrated brochures about their destinations.

The Home-School Connection

m Encourage students to ask their family members and acquaintances about trips they have taken

abroad in which they learned a great deal about the people, culture, and history of the place they

visited.

m Invite family members to watch the presentations during Phase 4. If the class presentations are

posted on a Web site (see the Options section), invite family members to visit the site.

This Project as a Model

In this project, students’ interest in culturally significant places around the world is stimulated with

Talking Walls and then channeled into a task grounded in the real world. Other tasks, and software

tools other than mPOWER, could be utilized to create a variety of similar projects. For example,

students could pose as travel agents asked to put together a multicultural world tour for a school

group, and be asked to create itineraries and background materials for the group using

AppleWorks.

Talking Walls and mPOWER can be combined in more general ways as well. Based on the places

and cultures described in Talking Walls, students can create mPOWER presentations about those

places, focusing on history, languages, religions, geography, or other topics.


